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Your	name,	your	company	representation,	and	your	business	affiliation—what	else	can	one	think	of?	Yes,	the	business	card	has	it	all!It	is	the	most	primitive	means	by	which	business	people	not	only	represent	their	contact	information	to	other	business	people	but	also	to	potential	customers	or	clients.	A	business	card	normally	reflects	the	giver’s	name,
company,	or	business	affiliation.One	might	think	that	carrying	a	small	card	is	useless	or	just	a	piece	of	paper,	but	with	business	cards,	that	is	not	the	case.	They	have	a	lot	more	to	offer.Simply	by	having	someone’s	business	card,	you	can	easily	contact	the	person	and	find	a	job	for	yourself	by	presenting	yourself	in	the	right	way	and	manner.	Knowing
the	business	is	a	major	step	in	finding	a	job.Business	information	is	easily	accessible	through	business	cards.	A	brief	business	introduction	is	on	the	card.	By	knowing	another	business,	one	can	create	partnerships.Going	into	much	longer	conversations	with	people	and	telling	them	about	your	business	each	time	is,	at	times	hectic.	A	business	card	saves
our	time	by	telling	the	other	person	necessary	details	like	in	what	business	you	are	in	and	what	you	do.Presenting	a	business	card	at	your	first	meeting	reflects	the	professional	approach	that	you	possess.	It	is	an	introduction	in	which	words	speak	while	you	are	silent.So,	all	the	professionals	have	your	business	card	and	keep	reminding	your	customers
about	you,	reflect	your	company	value	and	not	forget	to	differentiate	yourself	from	your	competitors	out	there.Of	course,	it	is.	You	are	here	on	this	page	and	we	make	sure	you	will	find	what	you	are	told.	Find	the	best	design	business	card	templates	for	FREE!	You	can	easily	download	and	customize	any	card	from	the	list.	Get	the	print	and	the	card	is
ready	to	present.Business	Card	File:	2	MBBusiness	Card	File	2	MBBusiness	Card	File:	2	MBBusiness	Card	File:	2	MBBusiness	Card	File:	2	MBBusiness	Card	File:	2	MB#1A	business	card	with	red	and	black	curves.	The	margins	are	given	at	the	four	sides	of	the	card	so	that	you	can	trim	it	for	the	size	of	your	requirement.DownloadDimension:	3.38″	x
2.13″	|	[Size:	66.0	KB]#2A	professional	design	business	card	with	nothing	left	to	be	improved.	Does	it?	The	card	is	generic	in	colors	so	that	it	can	be	used	for	any	type	of	business	or	profession.	Do	tell	us	about	which	business	you	belong	to	and	did	you	find	it	useful	for	you?DownloadDimension:	3.38″	x	2.13″	|	[Size:	88.0	KB]#3You	cannot	say	this	is	a
simple	card.	Creating	something	in	black	and	white	does	require	extra	skills	of	designing	and	let	me	say	this	card	has	a	fantastic	design.	Nowadays	it	is	hard	to	see	people	having	black	and	white,	but	we	believe	that	classic	look	is	never	old.DownloadDimension:	3.38″	x	2.13″	|	[Size:	106.0	KB]#4You	might	think	the	designing	of	this	card	is	simple.
Think	again!!!	as	this	card	has	taken	two	and	half	hours	to	design.	Would	you	believe	this?	However,	we	don’t	think	this	must	be	the	reason	for	using	it.	The	only	unique	reason	to	use	this	card	is	its	designing.	Isn’t	it	looking	fantastic?DownloadDimension:	3.38″	x	2.13″	|	[Size:	90.0	KB]#5If	10	is	for	best,	we	will	give	11	to	this	card.	A	masterpiece	of
designing	in	the	field	of	business	cards.	The	choice	of	colors	is	amazing	and	how	beautiful	are	those	curves!!!	I	mean	on	the	card.	Look	again!!!DownloadDimension:	3.38″	x	2.13″	|	[Size:	204.0	KB]#6A	business	card	that	can	have	much	information.	The	space	on	the	right	is	for	the	basic	details	of	an	individual,	however,	on	the	left,	there	is	enough
space	to	add	text	if	you	want.DownloadDimension:	3.38″	x	2.13″	|	[Size:	187.0	KB]#7Looking	at	this	business	card	will	make	you	keep	looking	at	it	for	some	time.	Our	designer	has	made	something	that	has	not	been	done	in	the	field	of	business	card	designs	so	far.	If	you	agree	with	this	then	this	card	is	for	you.	Let	us	know	how	you	like	this	card?
DownloadDimension:	3.38″	x	2.13″	|	[Size:	81.0	KB]#8Jumping	to	#8	should	not	be	boring	as	this	card	is	perfect	for	you.	What	else	you	need	other	than	this	card?	This	business	card	is	a	complete	package	of	designing	requirement.	Further,	you	will	not	be	missing	anything	important	to	write	on	the	card.DownloadDimension:	3.38″	x	2.13″	|	[Size:	425.0
KB]#9A	business	card	that	has	never	been	seen	in	the	market	so	far.	The	card	has	a	unique	design	and	very	few	designing	curves.DownloadDimension:	3.38″	x	2.13″	|	[Size:	526.0	KB]#10Last	on	the	list	is	again	amazing	to	see.	You	must	appreciate	the	efforts	of	the	designers	for	presenting	you	with	beautiful	design	business	card	for
free.DownloadDimension:	3.38″	x	2.13″	|	[Size:	115.0	KB]	Creating	a	business	card	on	Word	is	a	simple	process	that	anyone	can	do,	even	if	you’re	not	a	tech	whiz.	All	it	takes	is	opening	up	the	program,	picking	a	template	or	creating	your	layout,	entering	your	information,	and	tweaking	the	design	to	fit	your	brand.	After	that,	you	can	print	your
business	cards	straight	from	your	computer.	Easy,	right?	Before	we	jump	into	the	nitty-gritty,	let’s	get	one	thing	straight:	following	these	steps	will	give	you	a	professional-looking	business	card	that	you	can	be	proud	to	hand	out.	So	let’s	get	started!	Open	the	Microsoft	Word	program	on	your	computer.	When	you	open	Word,	you’ll	be	greeted	with	a
variety	of	options.	For	our	purposes,	we	want	to	focus	on	creating	a	new	document.	Select	a	business	card	template	or	create	a	new	blank	document.	Word	has	a	bunch	of	templates	ready	for	you	to	use.	If	you	want	to	save	some	time,	pick	one	that	suits	your	style	and	skip	ahead	to	entering	your	information.	Type	in	your	personal	or	business
information	into	the	template	or	blank	document.	This	is	where	you	make	the	card	truly	yours.	Add	your	name,	title,	company,	contact	details,	and	any	other	information	you	want	people	to	have.	Customize	the	design	by	changing	the	font,	colors,	and	adding	a	logo.	Use	your	brand	colors,	choose	a	font	that	represents	your	style,	and	don’t	forget	to
add	your	logo	for	that	extra	professional	touch.	Print	your	business	cards	on	business	card	stock	from	your	printer.	Make	sure	your	printer	settings	are	correct	and	that	you’re	using	the	right	kind	of	paper.	After	that,	it’s	just	a	matter	of	hitting	‘print’	and	waiting	for	your	brand	new	business	cards	to	come	out.	After	completing	these	steps,	you’ll	have
a	stack	of	business	cards	ready	to	distribute.	It’s	a	quick	and	cost-effective	way	to	make	sure	you’re	always	prepared	to	network	and	promote	your	business	or	services.	Use	high-quality	images	for	your	logo	to	prevent	any	blurriness	when	printed.	Stick	to	one	or	two	fonts	to	keep	your	design	clean	and	easy	to	read.	Make	sure	to	save	your	document
so	you	can	easily	update	or	reprint	your	business	cards	in	the	future.	Consider	adding	a	QR	code	to	your	business	card	for	easy	access	to	your	website	or	portfolio.	Always	do	a	test	print	on	regular	paper	before	printing	a	whole	batch	to	avoid	waste.	The	standard	business	card	size	is	3.5	inches	by	2	inches.	Yes,	you	can	insert	your	own	images	into	a
business	card	template	in	Word.	Make	sure	to	check	your	printer	settings	and	use	the	appropriate	business	card	paper	for	the	best	results.	Yes,	you	can	share	your	Word	document,	and	others	can	edit	it	if	they	have	Word	installed.	Yes,	you	can	create	double-sided	business	cards	by	setting	up	your	document	to	print	on	both	sides.	Open	Microsoft
Word.	Choose	a	business	card	template	or	create	a	new	blank	document.	Enter	your	personal	or	business	information.	Customize	the	design.	Print	your	business	cards.	So	there	you	have	it	–	a	straightforward	guide	on	how	to	make	a	business	card	on	Word.	It’s	a	perfect	solution	for	those	looking	to	create	professional	and	personalized	business	cards
without	the	fuss	of	complicated	design	software.	With	a	bit	of	creativity	and	attention	to	detail,	you	can	produce	business	cards	that	make	a	great	first	impression.	In	our	digital	age,	it’s	easy	to	overlook	the	power	of	a	physical	business	card.	However,	they’re	still	a	crucial	tool	for	networking	and	establishing	professional	relationships.	A	well-designed
business	card	can	provide	a	tangible	reminder	of	your	encounter	and	is	often	the	first	representation	of	your	brand	that	people	will	see.	Remember,	your	business	card	is	an	extension	of	your	professional	identity.	It	should	convey	the	essence	of	your	brand	and	the	quality	of	your	work.	By	following	the	steps	outlined	in	this	guide,	you	can	ensure	that
your	business	card	does	just	that.	Whether	you’re	attending	a	local	networking	event,	a	conference,	or	just	meeting	a	potential	client	for	coffee,	having	a	business	card	handy	can	open	the	door	to	new	opportunities.	So	why	not	take	the	time	to	create	a	set	of	business	cards	that	you	can	be	proud	of?	It’s	a	small	step	that	can	lead	to	big	things	for	you
and	your	business.	And	who	knows,	your	next	big	break	could	be	just	a	business	card	away.	Matthew	Burleigh	has	been	writing	tech	tutorials	since	2008.	His	writing	has	appeared	on	dozens	of	different	websites	and	been	read	over	50	million	times.	After	receiving	his	Bachelor’s	and	Master’s	degrees	in	Computer	Science	he	spent	several	years
working	in	IT	management	for	small	businesses.	However,	he	now	works	full	time	writing	content	online	and	creating	websites.	His	main	writing	topics	include	iPhones,	Microsoft	Office,	Google	Apps,	Android,	and	Photoshop,	but	he	has	also	written	about	many	other	tech	topics	as	well.	Read	his	full	bio	here.	Enjoy	sharper	detail,	more	accurate	color,
lifelike	lighting,	believable	backgrounds,	and	more	with	our	new	model	update.	Your	generated	images	will	be	more	polished	than	ever.See	What's	NewExplore	how	consumers	want	to	see	climate	stories	told	today,	and	what	that	means	for	your	visuals.Download	Our	Latest	VisualGPS	ReportData-backed	trends.	Generative	AI	demos.	Answers	to	your
usage	rights	questions.	Our	original	video	podcast	covers	it	all—now	on	demand.Watch	NowEnjoy	sharper	detail,	more	accurate	color,	lifelike	lighting,	believable	backgrounds,	and	more	with	our	new	model	update.	Your	generated	images	will	be	more	polished	than	ever.See	What's	NewExplore	how	consumers	want	to	see	climate	stories	told	today,
and	what	that	means	for	your	visuals.Download	Our	Latest	VisualGPS	ReportData-backed	trends.	Generative	AI	demos.	Answers	to	your	usage	rights	questions.	Our	original	video	podcast	covers	it	all—now	on	demand.Watch	NowEnjoy	sharper	detail,	more	accurate	color,	lifelike	lighting,	believable	backgrounds,	and	more	with	our	new	model	update.
Your	generated	images	will	be	more	polished	than	ever.See	What's	NewExplore	how	consumers	want	to	see	climate	stories	told	today,	and	what	that	means	for	your	visuals.Download	Our	Latest	VisualGPS	ReportData-backed	trends.	Generative	AI	demos.	Answers	to	your	usage	rights	questions.	Our	original	video	podcast	covers	it	all—now
on	demand.Watch	Now	1	Open	Word	and	click	New	to	create	a	new	blank	document.	If	you'd	prefer	to	create	your	business	card	yourself,	you	can	use	the	Table	tool	to	make	it	easier.	2	Click	the	Layout	tab	and	click	Margins.	Select	"Narrow"	to	make	the	margins	a	little	smaller	than	the	default	setting.	This	will	allow	you	to	fit	the	business	cards	on
the	page.[4]	3	Click	the	Insert	tab	and	then	click	Table.	A	grid	will	appear	beneath	the	Table	button.[5]	4	Create	a	2	x	5	table.	Use	the	grid	to	insert	a	table	that	is	two	cells	wide	and	five	cells	high.	5	Right-click	on	the	table's	selection	crosshair	and	select	"Table	Properties".	This	will	open	the	Table	Properties	window.	The	selection	crosshair	appears
in	the	upper-left	corner	of	the	table	when	you	hover	over	it.	6	Set	the	alignment	of	the	table	to	Center.	This	will	make	it	easier	to	make	the	cards	even.	This	setting	is	in	the	Table	tab	of	the	"Table	Properties"	window.	7	Click	the	"Row"	tab	and	check	the	"Specify	height"	box.	Enter	2"	and	change	the	drop-down	menu	to	"Exactly".	Note	that	the
standard	business	card	size	varies	by	country.	The	standard	US	business	card	size	is	3.5	inches	(8.9	cm)	x	2	inches	(5.1	cm).	Here	are	a	few	other	standards:	The	standard	business	card	size	is	also	3.5	inches	(8.9	cm)	x	2	inches	(5.1	cm)	in	Canada.	In	the	United	Kingdom,	the	standard	size	is	8.5	centimetres	(3.3	in)	x	5.5	centimetres	(2.2	in).	For
Australia,	the	standard	size	is	9.1	centimetres	(3.6	in)	x	5.5	centimetres	(2.2	in).	8	Click	the	"Column"	tab.	The	Preferred	width	box	is	checked	by	default,	but	you'll	want	to	change	the	specified	width	in	the	box.	Enter	3.5"	and	change	the	drop-down	menu	to	your	preferred	measurement,	such	as	"Inches".	9	Examine	your	table.	You	should	now	have	a
table	on	your	page	that	is	separated	into	ten	identical	business	card-sized	cells.	If	the	table	doesn't	fit,	you	may	have	to	extend	your	bottom	margin	by	a	tenth	of	an	inch.	10	Right-click	the	crosshair	again	and	select	AutoFit.	Choose	"Fixed	column	width".	This	will	prevent	the	table	from	changing	shape	as	you	add	information	to	the	first	cell.[6]	For
double-sided	business	cards,	copy	and	paste	the	table	onto	a	second	page	in	the	Word	document.	The	second	page	will	be	the	back	of	the	business	card.	11	Add	your	information	to	the	first	cell.	You	can	use	all	of	your	regular	Word	formatting	tools	while	typing	in	the	cell.	You	can	insert	text	boxes	and	images,	change	fonts,	add	color,	or	perform	any
other	formatting	that	you'd	like.	Adding	pictures	to	your	business	card	can	give	it	a	personal	touch	and	build	your	brand.	You	can	crop	and	rotate	the	images	as	needed.	Check	out	our	guide	to	formatting	in	Word	for	more	tips!	If	you're	creating	a	double-sided	card,	add	your	additional	information	to	the	first	cell	in	the	second	page	table.	12	Proofread
the	card.	Before	copying	the	information	into	each	of	the	other	cells,	take	the	time	to	review	it	now	for	any	errors	or	typos.	If	you	proofread	later,	you'll	have	to	change	each	cell	instead	of	just	changing	the	first	before	copying	it.	You	can	have	a	family	member	or	friend	review	your	cards	before	printing	to	make	sure	they're	free	of	errors.	13	Select	the
entire	first	cell	when	you're	satisfied.	To	do	so:	Move	your	cursor	to	the	bottom-left	corner	of	the	cell	until	it	turns	into	a	diagonal	arrow.	Click	and	the	cell's	contents	will	be	selected.	Press	Ctrl+C	(Windows)	or	⌘	Cmd+C	(Mac)	to	copy	the	contents	of	the	cell	to	the	clipboard.	14	Click	in	the	next	cell	and	paste	the	copied	information.	You	can	click
"Paste"	in	the	Home	tab,	or	you	can	press	Ctrl+V	(Windows)	or	⌘	Cmd+V	(Mac).	Your	copied	information	will	appear	in	the	cell	in	the	right	locations.	Repeat	this	for	each	of	the	cells	on	the	page.	Make	sure	that	your	business	card	organization	is	minimalistic.	You	can't	realistically	fit	everything	about	your	company	into	a	single	card—instead,	focus
on	the	most	important	info	like	your	company	logo,	name,	email	address,	physical	address,	website,	and	role	in	the	company.	15	Right-click	the	crosshair	again	and	select	"Table	Properties".	Click	on	the	Table	tab,	then	click	the	"Borders	and	Shading"	button	and	select	"None"	for	the	border.	This	will	ensure	that	parts	of	the	cell	borders	don't	appear
when	you	cut	the	cards.[7]	Make	sure	to	save	your	Word	document	in	case	you	want	to	edit	it	later!	16	Find	good	paper	for	the	cards.	You'll	want	a	nice	cardstock	paper	to	print	your	new	business	cards	on.	Make	sure	that	your	printer	supports	the	type	of	paper	that	you	get.	You	can	also	send	your	completed	file	off	to	a	printer	to	have	the	cards
professionally	printed.	To	print	double-sided	cards,	make	sure	to	select	Print	on	both	sides	in	the	print	menu.	This	will	print	the	second	page	(the	back	of	the	business	card)	on	the	back	side	of	the	paper.	Print	one	test	sheet	first	to	make	sure	everything	looks	good	and	that	the	back	side	is	aligned	properly	with	the	front.	17	Use	a	precision	cutting	tool.
Avoid	using	scissors	or	other	cutting	tools	that	require	you	to	maintain	a	straight	line.	Use	professional	paper	cutting	tools	to	make	sure	your	cuts	are	even	and	properly	measured.	Advertisement	Share	—	copy	and	redistribute	the	material	in	any	medium	or	format	for	any	purpose,	even	commercially.	Adapt	—	remix,	transform,	and	build	upon	the
material	for	any	purpose,	even	commercially.	The	licensor	cannot	revoke	these	freedoms	as	long	as	you	follow	the	license	terms.	Attribution	—	You	must	give	appropriate	credit	,	provide	a	link	to	the	license,	and	indicate	if	changes	were	made	.	You	may	do	so	in	any	reasonable	manner,	but	not	in	any	way	that	suggests	the	licensor	endorses	you	or	your
use.	ShareAlike	—	If	you	remix,	transform,	or	build	upon	the	material,	you	must	distribute	your	contributions	under	the	same	license	as	the	original.	No	additional	restrictions	—	You	may	not	apply	legal	terms	or	technological	measures	that	legally	restrict	others	from	doing	anything	the	license	permits.	You	do	not	have	to	comply	with	the	license	for
elements	of	the	material	in	the	public	domain	or	where	your	use	is	permitted	by	an	applicable	exception	or	limitation	.	No	warranties	are	given.	The	license	may	not	give	you	all	of	the	permissions	necessary	for	your	intended	use.	For	example,	other	rights	such	as	publicity,	privacy,	or	moral	rights	may	limit	how	you	use	the	material.	Creating	your	own
business	cards	in	Microsoft	Word	is	a	straightforward	process	that	can	save	you	time	and	money.	Whether	you’re	using	a	template	or	starting	from	scratch,	Word	provides	all	the	tools	you	need	to	design	professional-looking	business	cards.	This	tutorial	will	guide	you	through	both	methods,	ensuring	you	end	up	with	a	business	card	that	effectively
represents	your	professional	identity.	How	to	Use	a	Microsoft	Word	Business	Card	Template	Business	card	templates	for	Word	are	available	right	inside	the	application	from	Microsoft’s	searchable	online	library.	With	a	quick	search,	you	can	access	over	30	Microsoft	Word	business	card	templates,	free	of	charge.	Here’s	how:	Open	Word	and	Access
Templates		Navigate	to	the	“More	templates”	button	on	the	home	screen	to	explore	Word’s	template	options.			Type	“Business	Card”	in	the	search	box		Filter	the	templates	by	typing	“Business	Card”	in	the	search	box.			Select	Your	Preferred	Template			Choose	a	template	that	fits	your	needs,	such	as	the	“Flower	personal	business	card”	template	for	its
simplicity.			Create	Your	Business	Card		Click	“Create”	to	open	the	template	for	editing.			Customize	the	Template		Remove	default	images	by	selecting	them	and	pressing	“Delete“.			Insert	Your	Logo		Go	to	“Insert	>	Pictures	>	This	Device…”	to	add	your	logo.			Adjust	Image	Size		Resize	your	logo	to	fit	by	dragging	its	bounding	box.			Adjust	the	image
dimensions	to	fit	by	dragging	its	bounding	box			Edit	the	Text		Replace	placeholder	text	with	your	information.	The	text	will	automatically	update	as	you	type.			Customize	Font	and	Color		Highlight	your	name	or	any	text,	then	use	the	font	color	icon	in	the	“Home”	tab	to	choose	a	color.			Finalize	Your	Design		Continue	customizing	the	template	with
your	contact	information	and	details.			Print	Your	Business	Cards		Save	your	document,	print	and	cut	your	business	cards	on	card	stock	for	a	professional	finish.			How	to	Make	Business	Cards	in	Word	From	Scratch	If	you’d	rather	make	a	completely	custom	business	card	in	Word,	you	can	make	use	of	the	table	function	and	some	creative	formatting	to
do	so.	One	bonus	of	this	method	is	that	you’ll	have	a	well-defined	border	to	cut	around	after	you	print	them.	Start	with	a	Blank	Document		Create	a	new,	blank	document	in	Word.			Open	Custom	Margins	Options		You’ll	find	the	“Margins”	button	on	the	far	left	of	your	ribbon.			Set	Custom	Margins		In	the	Page	Setup	window,	click	the	“Margins”	tab	and
adjust	your	top	and	bottom	margins	to	0.25″.			Insert	a	Table			Add	a	2×5	grid	table	to	your	document	for	standard	business	card	sizes.			Adjust	Table	Properties		Right-click	on	the	table	to	set	specific	dimensions	for	cells	and	rows.			Open	the	“Table”	tab	and	click	the	“Center”	alignment	button			Open	the	“Cell”	tab	and	tick	“Preferred	width”,	then	set
it	to	3.25″			Open	the	the	“Row”	tab,	tick	“Specify	height”,	and	type	2″		Press	“OK”	when	you’re	done	adjusting	the	table’s	formatting.			Insert	a	picture	to	your	first	table	cell		To	do	so,	open	the	“Insert”	tab	in	your	ribbon,	then	click	“Pictures	>	This	Device..”			Navigate	to	your	logo	image	and	press	“Insert”			Click	the	image,	then	press	the	layout	icon
in	its	top	right	and	select	“Top	and	bottom”			Type	your	name,	address,	and	other	details	underneath	the	logo	and	highlight	your	name			In	the	“Home”	ribbon	tab,	click	the	font	dropdown	and	choose	a	font	for	your	name			Adjust	the	font	size	to	16	points			Optional:	change	your	font	color			Highlight	and	edit	the	information	under	the	name			Select
everything	in	the	cell	and	press	“Ctrl	+	C”	on	your	keyboard			Replicate	Across	Cells		Copy	and	paste	the	design	into	the	remaining	cells	to	create	a	full	page	of	business	cards.			Print	and	Cut		Print	the	business	cards	on	high-quality	card	stock	and	cut	them	out	along	the	table	borders.			Yes,	you	can	enhance	the	uniqueness	of	your	business	cards	by
using	custom	fonts.	First,	ensure	the	font	is	installed	on	your	system.	After	installation,	reopen	Word,	and	the	new	font	will	appear	in	the	dropdown	font	list	under	the	“Home”	tab.	Remember,	if	you	share	the	Word	file,	the	recipient	must	also	have	the	font	installed	to	see	the	design	as	intended.	To	ensure	your	design	is	viewable	by	anyone,	save	it	as	a
PDF.	In	Word,	go	to	“File”	>	“Save	As”	and	select	“PDF”	from	the	“Save	as	type”	menu.	This	format	preserves	your	layout	and	font	choices,	ensuring	others	see	the	design	exactly	as	you	intended,	regardless	of	their	software.	For	a	professional	look	and	feel,	choose	card	stock	between	80	and	110	lb	(pounds).	This	range	is	thick	enough	to	provide
durability	and	a	premium	feel	but	is	still	typically	compatible	with	most	home	and	office	printers.	Check	your	printer’s	manual	for	maximum	paper	thickness	to	avoid	jams.	Yes,	adding	a	QR	code	is	a	great	way	to	link	directly	to	your	professional	website	or	portfolio.	Generate	your	QR	code	using	an	online	generator,	then	download	the	code	as	an
image.	Insert	this	image	into	your	Word	document	by	going	to	“Insert”	>	“Pictures”	and	selecting	the	QR	code	from	your	files.	Adjust	the	size	without	distorting	the	code	to	ensure	scanability.	To	create	a	stylish	border	around	your	business	card,	select	the	table	or	cell	containing	your	design,	then	navigate	to	the	“Design”	tab	that	appears	under
“Table	Tools”	when	the	table	is	selected.	Here,	you	can	choose	from	various	border	styles,	colours,	and	thicknesses.	Be	mindful	of	the	print	margin	limitations	of	your	printer	to	ensure	the	border	prints	as	expected.	Yes,	printing	double-sided	business	cards	can	be	achieved	by	adjusting	your	printer	settings.	Look	for	an	option	like	“Print	on	Both
Sides”	or	“Duplex	Printing”	in	the	printer	dialogue	box	when	you	print	from	Word.	Depending	on	your	printer’s	capabilities,	you	may	need	to	manually	reinsert	the	paper	to	print	the	second	side.	Color	discrepancies	between	screens	and	printouts	are	common	due	to	differences	in	color	reproduction	technologies.	To	achieve	colors	that	are	as	close	as
possible	to	your	design,	use	a	calibrated	monitor	and	select	“Color	Management”	options	within	your	printer’s	properties.	It’s	also	wise	to	print	a	test	card	on	the	same	card	stock	you	plan	to	use	for	the	final	print	to	see	how	the	colors	actually	appear.	After	perfecting	your	business	card	design,	you	can	save	it	as	a	template	for	future	projects.	Go	to
“File”	>	“Save	As”	and	choose	“Word	Template	(*.dotx)”	from	the	“Save	as	type”	dropdown	menu.	This	saves	your	layout,	font,	and	design	choices,	making	it	simple	to	create	new	business	cards	with	the	same	branding.	How	can	I	align	text	vertically	in	my	business	card’s	cell	in	Word?	For	vertical	text	alignment	within	a	table	cell,	right-click	the	cell
and	select	“Table	Properties.”	Navigate	to	the	“Cell”	tab,	and	under	“Vertical	alignment,”	choose	either	“Top,”	“Center,”	or	“Bottom.”	This	feature	is	particularly	useful	for	achieving	a	balanced	look	in	your	design.	Can	business	cards	created	in	Word	be	considered	professional?	Absolutely.	With	careful	attention	to	layout,	font	choices,	and	print
quality,	business	cards	designed	in	Word	can	rival	those	made	with	specialized	design	software.	The	key	to	professionalism	is	in	the	details:	ensure	your	information	is	accurate,	your	branding	is	consistent,	and	your	printing	materials	are	of	high	quality.	What	if	I	want	to	use	a	non-standard	size	for	my	business	cards?	To	design	a	business	card	with
non-standard	dimensions	in	Word,	adjust	your	table	or	document	size	to	reflect	your	desired	dimensions.	Use	the	“Layout”	tab	to	modify	the	size	of	rows	and	columns	within	a	table,	or	use	the	“Page	Setup”	dialog	(accessible	under	the	“Layout”	tab)	for	overall	document	dimensions.	Always	verify	that	your	printer	can	accommodate	your	chosen	size
before	finalizing	your	design.	How	do	I	ensure	my	printed	business	cards	have	accurate	dimensions?	For	accurate	dimensions,	pay	close	attention	when	setting	up	your	document	and	printing.	Use	the	“Layout”	tab	to	set	exact	margins	and	table	dimensions,	and	always	print	a	test	page	on	regular	printer	paper	before	using	your	final	card	stock.	This
practice	ensures	any	adjustments	needed	for	margins	or	alignment	can	be	made	before	the	final	print.	How	to	duplicate	a	business	card	design	to	fill	a	page	in	Word?	After	designing	your	card,	you	can	easily	replicate	the	design	across	a	page.	If	you’re	using	a	table,	copy	the	contents	of	the	designed	cell,	then	paste	into	the	other	cells	of	the	table.	For
a	design	created	on	the	whole	page,	copy	the	entire	page	content	and	paste	it	into	a	new	blank	page	in	the	same	document.	Ensure	uniformity	in	your	document	setup	across	pages	for	consistent	results.	Can	I	import	designs	from	other	software	into	Word	for	my	business	card?	While	importing	a	complete	design	from	another	software	can	be	limited,
you	can	bring	in	aspects	like	logos	or	background	images.	Save	these	elements	as	images	in	a	format	like	JPEG	or	PNG,	then	use	Word’s	“Insert”	>	“Pictures”	option	to	add	them	to	your	business	card	design.	This	method	allows	for	some	level	of	design	portability,	though	recreating	text	and	other	elements	directly	in	Word	ensures	the	best	editability
and	print	quality.	How	can	I	print	my	business	cards	from	Word	without	a	border	appearing	around	them?	To	achieve	borderless	printing,	ensure	your	design	extends	to	the	very	edge	of	the	Word	document.	In	your	printer	settings,	select	“borderless	printing”	if	available.	Not	all	printers	support	borderless	printing,	especially	for	thicker	card	stock,	so
check	your	printer’s	capabilities	and	perhaps	consider	professional	printing	services	for	borderless	business	cards.	Related:	How	to	Add	an	Email	Signature	in	Outlook	Though	simply	writing	your	name	does	the	job,	an	email	signature	adds	a	degree	of	professionalism	to	your	email	while	promoting	your	social	media	and	other	platforms.	In	our	other
guide,	we	show	you	how	to	create	a	signature	in	Outlook	using	a	set	of	Microsoft-provided	templates.	We	also	cover	how	to	change	signatures	in	Outlook	if	you	have	one	already.			Related:	How	to	Remove	or	Clear	Formatting	in	Microsoft	Word	If	you	pasted	text	into	your	document	from	the	internet	or	another	document,	you	may	find	it	necessary	to
learn	how	to	clear	formatting	in	Word.	The	in-built	feature	will	remove	any	display	issues	you	may	have	and	return	text	to	its	default	form.	In	our	other	guide,	we	show	you	how	to	clear	formatting	in	Word	via	the	Styles	and	Font	windows	so	you	can	get	your	document	back	to	a	blank	slate.			Related:	How	to	Customize	the	Ribbon	in	Microsoft	Word,
PowerPoint,	Excel,	and	Outlook	For	many	years	now,	Microsoft	Office	has	used	an	intuitive	ribbon	system	to	help	users	easily	find	and	organize	the	tools	they	require.	Though	many	are	familiar	with	the	interface,	fewer	realize	that	you	can	actually	customize	the	ribbon	in	MS	Word,	PowerPoint,	Excel,	and	Outlook.	In	our	other	guide,	we	show	you	how
to	customize	the	ribbon	in	Microsoft	Word,	PowerPoint,	Excel,	or	Outlook,	including	how	to	add,	remove,	and	rename	tabs	and	items.			Last	Updated	on	November	7,	2024	9:26	pm	CET	You	can	use	any	fancy	design	software	for	making	business	cards.	However,	if	you	are	in	a	hurry	and	do	not	have	access	to	other	software,	you	can	use	Microsoft
Word.	Starting	from	Scratch	Using	Templates	We	will	show	you	how	to	make	business	cards	in	Microsoft	Word.	Let	us	begin.	This	method	uses	the	basic	tools	available	in	Word	to	make	your	business	card.	Open	a	new	blank	document	in	Word.	Click	the	Layout	tab	in	the	top	menu	bar	to	change	the	ribbon.	In	the	section	Page	Setup,	click	the	Margins
icon.	A	drop-down	menu	will	appear.	Click	the	Narrow	margin.	Click	the	Insert	tab	in	the	top	menu	bar	to	change	the	ribbon.	In	the	section	Tables,	click	the	Table	icon.	The	Insert	Table	dialog	box	will	open.	Select	an	array	of	5×2.	A	table	with	two	columns	and	five	rows	will	appear	in	the	document.	Click	the	table.	Right-click	the	selection	cross-hair	in
the	top	right	corner	of	the	table.	A	menu	will	open.	Click	the	Table	Properties…	icon.	A	dialog	box	for	Table	properties	will	open.	Under	Alignment,	click	on	the	Center	icon.	This	will	place	the	table	in	the	center	of	the	document.	Click	the	Row	tab	at	the	top.	Under	the	heading	Size,	Click	the	box	on	the	left	of	Specify	height:.	Type	2”	inside	the	box	on
the	right	of	Specify	height:.	Click	the	triangle	beside	the	box	on	the	right	of	Row	height	is:,	and	click	Exactly.	Click	the	Column	tab	at	the	top.	Under	the	heading	Size,	Click	the	box	on	the	left	of	Preferred	Width:.	Type	3.5”	inside	the	box	on	the	right	of	Preferred	Width:.	Click	the	triangle	beside	the	box	on	the	right	of	Measure	in:,	and	click	inches.
Click	the	OK	tab	at	the	bottom.	The	array	on	the	page	will	change	to	size	3.5”	x	2”.	Note:	The	standard	size	of	business	cards	in	US,	Canada,	and	India	is	3.5”	x	2”.	For	UK,	the	standard	size	is	3.3”	x	2.2”.	You	may	choose	any	other	size	according	to	your	requirement.	Type	your	details	inside	the	first	cell.	Select	the	text	you	have	just	typed.	Press
CTRL+C	on	your	keyboard	to	copy	the	text	to	the	clipboard.	Click	inside	the	next	cell.	Press	CTRL+V	on	your	keyboard	to	paste	the	text	from	the	clipboard.	Repeat	for	all	the	cells.	Select	the	text	in	all	the	cells.	Use	Word	features	to	center	the	text	horizontally	and	vertically.	Change	the	font,	color,	size,	and	position	of	the	text	as	necessary.	Remove	all
borders	from	the	cells.	Now,	your	business	cards	are	ready	for	printing.	This	method	uses	templates	in	Word	to	make	business	cards.	Open	Word.	In	the	left	pane,	click	the	New	tab.	In	the	search	bar,	type	business	card.	Click	the	search	icon.	Word	will	open	a	number	of	business	card	templates.	Click	the	one	you	find	most	appropriate	for	your
requirements.	A	dialog	box	will	open.	Click	on	the	Create	icon.	Word	will	open	a	page	with	the	cards	in	an	array.	Replace	the	information	in	the	first	card	with	appropriate	data.	Change	the	font,	color,	size,	and	position	as	necessary.	The	rest	of	the	cards	will	change	automatically.	Now,	your	business	cards	are	ready	for	printing.	We	have	shown	you
two	methods	of	making	a	business	card	using	Microsoft	Word.	Use	the	one	most	suitable	for	your	purpose.	If	you	have	any	questions,	please	enter	them	in	the	comments	section	below.	“Every	element	of	these	cards	were	designed	to	be	accurate	to	1/1000	of	an	inch,	and	I	can	tell	there	was	no	deviation	among	them,	because	they're	all	clear!	This	is
the	quality	of	work	I	was	looking	for,	something	I	know	I	wouldn't	have	been	able	to	achieve	elsewhere."	CEO	&	Director	of	Web	Operations	-	ThinkCode	Creating	your	own	business	card	template	from	scratch	using	Word	is	a	great	way	to	experience	the	joy	of	extreme	frustration.	After	much	pain	and	anguish,	we	finally	worked	through	the	quirks
and	now	you	can	avoid	similar	pain	by	just	downloading	one	of	the	free	business	card	templates	below.	In	addition	to	the	business	card	templates,	you'll	also	find	that	we've	explained	how	to	use	them	below	-	how	to	add	your	logo,	how	to	easily	modify	the	colors,	and	how	to	quickly	copy/paste	your	business	card.	Advertisement	At	your	local	office
supply	store,	you'll	probably	find	2	main	types	of	card	stock	for	the	business	cards:	10	cards	per	page	or	8	cards	per	page.	The	purpose	of	the	8	per	Page	format	is	to	allow	you	to	have	color	that	extends	all	the	way	to	the	edge	of	the	card.	All	our	business	card	templates	are	designed	for	standard-size	business	cards:	3.5"	x	2"	Vertex42™	Business	Card
Template	Collection	Cost:	Free	($0.00)License:	Limited	Use	(Applies	to	all	the	business	card	templates	listed	below)Required:	Microsoft	Word®	2002(XP),	2003,	2007,	2010	Screenshot	Format:	10	cards/page	Create	a	calendar	that	you	can	print	onto	a	business	card	magnet,	store	in	your	wallet,	or	print	on	the	back	side	of	your	normal	business	card
so	that	people	will	want	to	use	your	card	continually	for	reference.	(Thanks	to	Nathan	Smith	for	the	suggestion	and	ideas)	Download	the	Excel	file	to	format	and	create	the	calendar	for	any	year,	then	copy	and	paste	into	the	business	card	template	as	a	picture.	Download	for	Word	(.docx)	Business	Card	Calendar	Creator	(.xlsx)	PDF	Preview	Style	10-
AFormat:	10	cards/page	Not	only	is	the	design	simple	and	sophisticated,	it	is	also	easy	on	printer	toner.	You	don't	need	a	color	printer,	but	you	can	of	course	change	the	text	to	whatever	color	you	wish.	Download	for	Word	(.docx)	|	Download	for	OpenOffice	(.odt)	PDF	Preview	Style	10-BFormat:	10	cards/page	The	reversed	out	text	is	a	nice	way	to
highlight	your	contact	information.	Though	it	is	in	grayscale,	you	can	change	the	colors	however	you	like.	I	recommend	keeping	the	text	white	with	a	darker	background	color.	This	card	works	well	for	adding	a	logo	that	requires	a	white	background.	Download	for	Word	(.docx)	|	Download	for	OpenOffice	(.odt)	PDF	Preview	Style	10-CFormat:	10
cards/page	For	more	impact,	this	business	card	template	uses	two	big	hits	of	color,	which	you	can	easily	change.	See	the	instructions	below.	Download	for	Word	(.docx)	|	Download	for	OpenOffice	(.odt)	PDF	Preview	Style	8-AFormat:	8	cards/page	The	greens	and	browns,	along	with	the	angled	hits	of	color	lead	to	a	very	organic	feel.	If	you	choose	a
different	color	scheme,	be	careful	to	go	with	colors	that	work	well	together.	Download	for	Word	(.docx)	|	Download	for	OpenOffice	(.odt)	PDF	Preview	Style	8-BFormat:	8	cards/page	The	design	of	this	business	card	is	meant	to	separate	the	most	important	information	(company	name,	your	name,	title	&	email)	from	the	secondary	information.	With	the
color	going	to	the	edge	of	the	card,	the	design	is	simple	yet	strong.	Download	for	Word	(.docx)	|	Download	for	OpenOffice	(.odt)	PDF	Preview	Style	8-CFormat:	8	cards/page	The	off	center	white	box	and	san-serif	font	give	this	card	a	very	modern	and	clean	feel.	Download	for	Word	(.docx)	|	Download	for	OpenOffice	(.odt)	PDF	Preview	Style	8-D:	8
cards/page	This	business	card	template	is	very	bold	with	its	full	hit	of	color.	If	you	change	the	color	I	recommend	staying	monochromatic	(using	different	shades	of	the	same	color).	This	business	card	will	definitely	stand	out	in	a	crowd	of	mostly	white	business	cards.	Download	for	Word	(.docx)	|	Download	for	OpenOffice	(.odt)	PDF	Preview	Style	8-
EFormat:	8	cards/page	This	business	card	design	is	similar	to	style	10-C	above,	accept	it	takes	advantage	of	the	page	format	which	allows	the	colors	to	go	to	the	very	edge	of	the	card.	This	subtle	difference	increases	the	professional	feel	of	the	card.	Download	for	Word	(.docx)	|	Download	for	OpenOffice	(.odt)	Tips	for	Customizing	the	Business	Card
Template	Editing	your	Business	Card	TEXT:	When	you	open	the	file,	you'll	see	that	only	one	of	the	business	cards	contains	text.	You	will	only	need	to	edit	a	single	business	card,	because	you'll	be	copying/pasting	later	on.	GRAPHICS:	We	realize	that	one	of	the	main	things	you'll	want	to	do	with	these	templates	is	choose	your	own	color	scheme,	so	we
tried	to	make	that	simple	by	grouping	all	of	the	drawing	objects	(lines,	background	colors,	etc.)	so	that	you	can	change	colors	all	at	once.	Hint:	You	can	click	on	the	"Show/Hide	¶"	button	to	view	anchor	points	and	tabs.	You	may	need	to	use	the	Selection	tool	(the	Arrow)	to	select	some	objects.	Adding	a	Logo	to	the	Business	Card	Template	When	using
Word,	inserting	drawing	objects	and	images	can	mess	things	up,	and	sometimes	it	does	in	fact	take	an	expert	to	figure	out	why	things	are	going	wrong.	I	don't	guarantee	that	the	following	steps	will	work	in	all	versions	of	Word,	but	hopefully	you'll	get	the	main	idea	and	be	able	to	format	the	objects	and	images	as	needed.	In	Word	2003:	Place	the
cursor	inside	of	one	of	the	business	cards.	Go	to	Insert	>	Picture	>	From	File...	to	insert	your	logo.	Double-click	on	the	image	that	you	just	inserted	into	your	business	card	or	go	to	Format	>	Picture.	If	you	are	inserting	or	editing	a	drawing	object,	select	it	using	the	selection	tool	and	then	go	to	Format	>	Object.	In	the	Format	Object	or	Format	Picture
dialog	box,	go	to	the	Layout	tab	and	select	Behind	text	or	In	front	of	text	(under	Wrapping	style).	In	the	Layout	tab,	click	on	the	Advanced	button,	which	will	take	you	to	the	Advanced	Layout	dialog	box.	I	usually	set	the	vertical	alignment	to	Absolute	position	of	X"	below	the	Margin.	Also	make	sure	Allow	overlap	and	Layout	in	table	cell	are	selected.
We	have	found	that	positioning	objectives	relative	to	the	Page	leads	to	the	greatest	compatibility	between	versions	of	Word	and	OpenOffice.	Copy	Your	Business	Card	We	designed	our	templates	so	that	you	can	edit	a	single	business	card	and	then	copy	it	to	the	rest	of	the	business	cards	on	the	page.	Each	of	the	business	cards	represents	a	cell	within	a
table.	It	is	important	that	you	select	the	entire	contents	of	the	cell.	Put	your	cursor	inside	one	of	the	business	cards.	Go	to	Table	>	Select	>	Cell	Press	Ctrl+c	to	Copy	Press	Tab	to	move	to	the	other	cells	in	the	table	if	you	are	using	the	10-up	version,	or	use	the	mouse	to	click	in	the	other	cells	if	you	are	using	the	8-up	version.	Press	Ctrl+v	to	Paste
Print	a	Test	Page	What	you	see	on	your	screen	may	not	be	what	you	see	when	you	print	(especially	if	graphic	objects	are	used),	so	before	printing	out	100	sheets	of	unusable	business	cards,	test	on	a	regular	piece	of	paper.	Other	Free	Business	Card	Templates	Microsoft	Word	Business	Cards	at	templates.office.com	-	Microsoft's	gallery	includes	some
business	card	templates	for	Word	and	PowerPoint.	Avery	Business	Card	Templates	at	avery.com	-	Here	you	will	find	a	link	to	the	Templates	for	Business	Cards,	of	which	there	are	a	great	many.	The	downside	is	that	you	have	to	complete	a	sign-up	form	to	download	them	(which	you	don't	have	to	do	at	Vertex42).	Business	Card	Design	Creattica	-	Some
very	creative	business	cards!	Disclaimer:	Vertex42.com	is	not	affiliated	with	the	Avery	Dennison	Corporation.
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